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What’s new NX9.0 

Fundamentals 
 
Ribbon bar interface 

NX9.0 มีการปรับเปลีย่นรูปแบบของการจดัเก็บ Icon ใหม่ในแบบ NX Ribbon bar interface โดย
ได้มีการแบง่หมวดหมู่ของชุดค าสัง่ เพื่อให้ผู้ใช้งานสามารถเข้าถึงค าสัง่ได้สะดวกขึน้ ดงัรูป 

 

NX9 Ribbon bar 

 

# Component Description 

1 Tab Tab แบง่ส าหรับแบง่หมวดหมู่ของชุดค าสัง่หลกั 

2 Group ชุดค าสัง่ยอ่ย  

3  Command 
Finder  

ตวัช่วยในการค้นหาค าสัง่ 

4 Full Screen  เปิดการแสดงผลแบบเต็มจอ 

5 Minimize 
Ribbon  

ซอ่น Ribbon Tab 

6 Help  F1 หรือ ขอความช่วยเหลอืด้านข้อมลู 

7 Toolbar 
Options  

เปิดค าสัง่เพิ่มเติม ใน Group นัน้ๆ 
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Ray Traced Studio 
 

 เป็น Option ในการท าภาพเสมือนจริง โดยจะมีการแสดงผลแยกออกมาเป็นหน้าตา่งใหม่ ซึง่ผู้ใช้
สามารถปรับแตง่คา่แสง-เงา และพืน้หลงัได้สะดวกยิ่งขึน้ , สามารถ Save เป็น File JPEG , PNG , TIFF 
คณุภาพสงูได้ 

 

Dynamic rendering in the Ray Traced Studio window 

 

Global Illumination effects 

 

Inter-object reflection and refraction effects 
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สามารถเข้าถึงค าส่ังได้ที่  
1. Render Tap > Ray Traced Studio 
2. Command Finder > พิมพ์ Ray Traced Studio 

 

 

 

 

 
 
 
Measure Point 

NX9 ได้มีการเพิ่มค าสัง่ Measure Point เพื่อให้ส าหรับหาต าแหนง่ X,Y,Z โดยจะวดัเทียบกบั 
WCS หรือ Absolute Work Part และ CSYS 

จากตวัอยา่งด้านลา่ง บริเวณมมุท่ีต้องการหาต าแหนง่นัน้ เกิดจากการ Trim Surface จึงมีผลท า
ให้จุดยอด หรือจุดมมุอาจจะไม่สามารถ หาคา่ได้ ซึง่จะต้องสร้าง Feature Sphere ขึน้มาเพื่อใช้วดัคา่แทน 
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สามารถเข้าถึงค าส่ังได้ที่  

1. Analysis Tab > Measure Group > More > Measure Point 
2. Command Finder > พิมพ์ Measure Point 
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Lock Rotations 
เป็นค าสัง่ท่ีใช้ส าหรับ Lock View เพื่อไม่ให้สามารถหมนุด้วยเมาท์ปุ่ มกลางหรืออุปกรณ์หมนุ 3D 

ได้ แตจ่ะสามารถ Zoom , Pan ได้ตามปกติ 

ในกรณีท่ีเปิดมมุมองแบบหลายวิว ผู้ใช้งานสามารถเลอืก Lock View เป็นบางวิวได้และยงั
สามารถใช้งานร่วมกบั Synchronized Views ได้อีกด้วย 

 
 
Synchronize Views 

เป็นค าสัง่ท่ีเปิดใช้ได้เฉพาะมมุมองแบบหลายหน้าตา่งเทา่นัน้ (Multiple View) โดยจะมีหน้าที่
บงัคบัให้ View ท่ีเลอืกไว้หมนุไปพร้อมๆ กนั รวมถึงการ Zoom, Pan ด้วย 

 
สามารถเข้าถึงค าส่ังได้ที่  

1. คลกิขวาท่ี View ท่ีต้องการ > เลอืก Lock Rotations หรือ Synchronize Views 
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CAD 

 

Sketch 

1. Sketch dimensions  
มีการเพิ่มเติมค าสัง่ Linear Dimension, Radial Dimension, and Angular Dimension 

เข้าไปในชุดค าสัง่ Rapid Dimension 

 

เพิ่มรายละเอียดในการบอกขนาดให้เหมือนกบัการบอกขนาดใน Drafting และ PMI โดย

สามารถตัง้คา่ได้โดยการเปิด Option : Enable Dimension Scene Dialogs  

ซึง่จะสามารถก าหนดคา่ Tolerance , Lettering , Arrow ได้เหมือนกบัการตัง้ Annotation 

ใน Drafting  
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2. 2D Synchronous Technology :  
เพิ่มชุดค าสัง่ Synchronous Technology เข้ามาใช้งานในหมวด Sketch โดยจะมีอยู่

ทัง้หมด 4 ค าสัง่ คือ Move Curve , Offset Move Curve , Resize Curve และ Delete Curve 
 

 

 
  เหตผุลท่ีต้องใช้ชุดค าสัง่ 2D Synchronous Technology คือ เม่ือผู้ใช้งานก าหนด 
Constrain ให้กบั Sketch จน Fully Constrain แล้ว จะไม่สามารถท าการเคลือ่นย้ายหรือแก้ไข Sketch ได้
เลย จึงจ าเป็นต้องใช้ 2D Synchronous Technology เพื่อช่วยในการ Move หรือ Edit 

 

 

สามารถเข้าถึงค าส่ังได้ที่  
1. Home Tab > Direct Sketch Group  
2. Command Finder > พิมพ์ Move Curve , Offset Move Curve ,  
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3. Rigid sketch groups :  

เม่ือผู้ใช้งานท าการก าหนด Group ให้กบั Sketch ก็จะสามารถก าหนด Constrain แบบ 

Rigid Constrain ได้ เพื่อให้ในขณะท่ีก าลงัแก้ไข Group ใดอยู ่Group อ่ืนๆ ก็จะไม ่Active  

โดยจะสงัเกตเุห็นสญัลกัษณ์  เกิดขึน้ 

 

 

เหตผุลท่ีต้องใช้ Rigid sketch groups คือ  

1. สามารถท าการเคลือ่นย้าย Rigid sketch groups ได้โดยไม่เสยีรูปร่าง 

2. ท าให้งา่ยในการก าหนดขนาด Dimension เพื่อ Group ท่ีไม่ Active จะไม่แสดง 

Dimension 

3. Update Sketch ได้รวดเร็ว 

สามารถเข้าถึงค าส่ังได้ที่  
1. คลกิขวาท่ี Sketch ท่ีต้องการ > เลอืก New Sketch Group 
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4. Snip into Patches :  

เป็นค าสัง่ท่ีใช้ส าหรับเปลีย่นผิว B-Surface ให้เป็นผิว Patch ยอ่ยๆ เพื่อให้งา่ยในการลบ

หรือแก้ไข 

 

สามารถเข้าถึงค าส่ังได้ที่  
1. Surface Tab > Edit Surface Group > More > Snip into Patches 
2. Command Finder > Snip into Patches 
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5. Rib :  
เป็นค าสัง่ใหม่ท่ีใช้ส าหรับสร้าง Rib ให้กบัชิน้งาน โดยอาศยัการเขียนเส้น Sketch และ

ค าสัง่ Extrude มารวมกนั 

 

 
 ผู้ใช้งานสามารถเลอืกทิศทางของ Rib ได้วา่ จะให้เป็นแบบตัง้ฉากหรือขนาน 

 
 

สามารถเข้าถึงค าส่ังได้ที่  
1. Home Tab > Feature Group > More > Rib 
2. Command Finder > Rib 

 

1. เส้นแบบปลายเปิด 

2. เส้นแบบปลายปิด 

3. เส้นแบบต่อเนื่องท้ังแบบเปิดและปิด 

4. เส้นร่วมแยกตวั Y 

แบบตัง้ฉาก แบบขนาน 
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6. Mirror Geometry : 

เป็นค าสัง่ท่ีใช้ในการ Mirror ชิน้งาน โดยได้น ามาแทนท่ีค าสัง่ Mirror ท่ีอยูใ่นค าสัง่ 

Instance Geometry โดยสามารถ Mirror วตัถตุา่งๆได้ดงันี ้

 Curve 

 Edge 

 Face 

 Datums 

 Solid Body 

 Point 

 CSYS 

 Plane 

 Sheet Body 
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สามารถเข้าถึงค าส่ังได้ที่  
1. Home Tab > Feature Group > More > Mirror Geometry 
2. Command Finder > Mirror Geometry 
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Analyze Pockets and Blend Pocket 
 เป็นค าสัง่ท่ีใช้ในการตรวจสอบหลมุ Pocket และสร้าง Fillet โดยแบง่ออกเป็น 2 ค าสัง่ คือ 
Analyze Pockets และ Blend Pocket 

 

 Analyze Pockets  

 

 

 Blend Pocket  

 

 

  Analyze Pockets 

ค าสัง่ Analyze Pockets นัน้ จะท างานร่วมกบัระบบ HD3D โดยจะจ าแนกประเภทของการ 
Analyze ดงันี ้

 

Undercuts 

 

 HD3D Tools 

 Results 

 

 Object Name  Part  Result 
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Analyze Pocket 
Undercuts 

Face: <#> 

<partfile>.prt 
<partfile>.prt 
<partfile>.prt 

Passed with... 
Passed with... 
Passed with... 

 

 

Acutely Angled Walls 

 

 HD3D Tools 

 Results 

 

 Object Name  Part  Result 

Analyze Pocket 
Acutely Inclined Walls 

Face: <#> 
Face: <#> 

<partfile>.prt 
<partfile>.prt 
<partfile>.prt 
<partfile>.prt 

Passed with... 
Passed with... 
Passed with... 
Passed with... 

 

 

Tool Inaccessible Areas 

 

 HD3D Tools 

 Results 

 

 Object Name  Part  Result 
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Analyze Pocket 
Tool Inaccessible Areas 

Face: <#> 
Face: <#> 

<partfile>.prt 
<partfile>.prt 
<partfile>.prt 
<partfile>.prt 

Passed with... 
Passed with... 
Passed with... 
Passed with... 

 

 
สามารถเข้าถึงค าส่ังได้ที่  

1. Menu Analysis > Analyze Pockets  
2. Command Finder > Analyze Pockets  
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  Blend Pocket 

หลงัจากผา่นการท า analyzed pocket แล้ว ผู้ใช้งานสามารถเลอืกใช้ค าสัง่ Blend Pocket 
ตอ่เน่ืองได้เลย โดยค าสัง่จะท าการสร้าง Fillet โดยเทียบจาก Tool ท่ีใช้ในการ Machine ดงันี ้

 End Mill 

 T Cutter 

 Spherical Mill 

 

 

Swarf Cut Wall 

Swarf cuts the wall and cuts the floor only until tangent to the ramped 
floor near the wall. There are no sharp edges. 

 

Cut Floor and Swarf 
Cut Wall 

Cuts the floor until the tool touches the top of the wall, and swarf cuts 
the wall. This leaves a sharp edge. 

 

Cut Floor 

Cuts only the floor, leaving the wall perpendicular to the floor. There are 
no sharp edges. 

 

Swarf Cut Wall and 
Floor 

Cutter is angled to swarf cut both the wall and floor. This leaves a sharp 
edge. 
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สามารถเข้าถึงค าส่ังได้ที่  
1. Home Tab > Feature Group > More > Detail Feature > Blend Pocket 
2. Command Finder > Blend Pocket 
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Combine or separate tool bodies 
 

 เป็นค าสัง่ท่ีช่วยในการแยกชิน้งานออกจากกนั (subtract) หรือรวมชิน้งานเข้าด้วยกนั (Unite)ได้
รวดเร็วขึน้ โดยผู้ ใช้งานสามารถคลกิขวาแล้วเลอืก Convert to Subtract หรือ Convert to Unite  

 

 
สามารถเข้าถึงค าสัง่ได้ท่ี 

 คลกิขวาท่ีค าสัง่ Unite หรือ Subtract ในสว่นของ Part Navigator จากนัน้เลอืก Convert to 
Subtract หรือ Convert to Unite 
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Select intersection edges in Edge Blend and Draft 
 

เป็นตวัช่วยในการเลอืกขอบของค าสัง่ edge blend และ draft เพื่อให้สามารถเลอืกขอบท่ีตดักนัได้
งา่ยขึน้ โดยให้ปรับท่ี Selection Intent ให้เป็น Feature Intersection Edges แล้วเลอืกท่ีชิน้งานท่ีต้องการ
ท า edge blend หรือ draft 

  

In this example: 

 

A shelled extrude 
feature pierces two 
sections of a solid body, to 
which it is united. 

 

With the Edge Blend 
dialog box open and the 
Feature Intersection Edges 
Selection Intent rule active, 
selecting the extrude 
feature produces a preview 
of the blend intersection 
edges. 
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Clicking OK or Apply 
creates the edge blend. 

 

สามารถเข้าถึงค าสัง่ได้ท่ี 

 เม่ือเลอืกใช้ค าสัง่ Edge Blend หรือ Chamfer ให้ปรับ Selection Intent เป็นแบบ Feature 
Intersection Edges ตามรูปด้านลา่ง 

 

 

Replace Edge 
เป็นค าสัง่ในการแก้ไขขอบของ Surface ซึง่เป็นค าสัง่ท่ีมาแทนท่ีค าสัง่ Edit Sheet Boundary  

สามารถเข้าถึงค าสัง่ได้ท่ี 

1. Menu Edit > Surface > Replace Edge 
2. Command Finder > พิมพ์ Replace Edge 
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Local Untrim and Extend 

เป็นค าสัง่ัใ้ช้ส าหรับการ Untrim หรือยืดขอบออก โดยผู้ใช้สามารถท า Untrim ขอบ Surface ได้
หลายๆ ขอบและสามารถลบรูบนผิว Surface ได้สะดวกขึน้ 

 

 
Original surface 

 

 
Extended surface 

 

 
Trimmed surface 

 

 
Untrimmed surface 

 

 
Deleted hole 
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สามารถเข้าถึงค าสัง่ได้ท่ี 

1. Surface Tab > Edit Surface Group > More > Boundary > Local Untrim and Extend 

 
 

2. Command Finder พิมพ์ Local Untrim and Extend 
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Rough Offset enhancement 
 

เป็นการเพิ่มความสามารถของค าสัง่ Rough Offset โดยสามารถท ากบั facet sheet body  

 

 

สามารถเข้าถึงค าสัง่ได้ท่ี 

1. Home Tab > Feature > More > Offset/Scale > Rough Offset 

 

2. Command Finder พิมพ์ Local Untrim and Extend 
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Thicken enhancements 
 

เพิ่มความสามารถให้กบัค าสัง่ Thicken โดยสามารถเลอืกขอบเขตของการ Offset แบบ Region 
ได้และยงัสามารถก าหนดคา่ความหนาที่แตกตา่งกนัได้อีกด้วย 

 

Original surface with curves on the surface. 

 

One thicken feature with 2 thicknesses and 2 pierced 
areas. 

 

สามารถเข้าถึงค าสัง่ได้ท่ี 

1. Home Tab > Feature > More > Offset/Scale > Thicken 

 

2. Command Finder พิมพ์ Thicken 
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Pattern enhancements 
 

 ได้มีการน าค าสัง่ Pattern Geometry มาแทนท่ี Instance Geometry และได้มีการปรับปรุงให้กบั
ค าสัง่ Pattern Face และค าสัง่ Pattern Geometry ให้เป็นรูปแบบเดียวกนั ท าให้สามารถท า Pattern ได้
หลากหลายมากขึน้ ดงัรูป 

 
Linear 

 
Polygon 

 
Along 

 
Reference 

    

 
Circular 

 
Spiral 

 
General 

 
Helix 

 

 สามารถเติมเต็ม Pattern ให้อยูภ่ายในขอบเขตได้งา่ยขึน้ 

 

 

 ในกรณีท่ีท า Linear Layout ก็สามารถท าให้เป็นแบบ Symmetric ทัง้ ซ้าย-ขวา , บน-ลา่ง  
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 สามารถ Pattern แบบ Circular และ Polygon ได้ 

 

 

 

 

  Linear 4 x 4 layout   

   

 

     
 

 

 

 

 

Delete 

Multiple instances of 

the pattern can be 

deleted at one time. 

Clock 

Each move shown 

above is a separate 

clocking operation. 
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สามารถเข้าถึงค าสัง่ได้ท่ี 

1. Home Tab > Feature > More > Associative Copy > Pattern Geometry 

 

 

2. Command Finder พิมพ์ Pattern Geometry 
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Synchronous Modeling 
Move Edge 
 เป็นค าสัง่ท่ีใช้ในการแก้ไขขอบของชิน้งานโดยการ move ซึง่มีลกัษณะการใช้งานดงันี ้จากตวัอยา่ง
ดา่นลา่ง ต้องการแก้ไขขอบของชิน้งาน 

 

2. เลอืกท่ีขอบท่ีต้องการ move 

 

3. ดงึขอบลงตามทิศทางที่ต้องการ 

 

4. เลอืกขอบด้านลา่งเพื่อท าการ move 
อีกครัง้ 

 

5. เสร็จสิน้การแก้ไข 
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สามารถเข้าถึงค าสัง่ได้ท่ี 

1. Home Tab > Synchronous Modeling  > More > Move Edge 

 

 
2. Command Finder พิมพ์ Move Edge 
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Offset Edge 
 

เป็นค าสัง่ท่ีใช้ในการแก้ไขขอบของชิน้งานโดยการ offset ซึง่มีลกัษณะการใช้งานดงันี ้

 

  

 

Original model 

An edge is selected, and an offset applied and previewed 

Result of offset edge 

 

สามารถเข้าถึงค าสัง่ได้ท่ี 

1. Home Tab > Synchronous Modeling  > More > Offset Edge 
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Facet Body Preparation 
 

Create Box 
โดยปกติค าสัง่ Create Box จะอยูห่มวดของ Progressive Die Wizard และ Mold Wizard เทา่นัน้ 

แต ่NX9 สามารถใช้ค าสัง่ Create Box ในหมวดของ Modeling ได้แล้ว และยงัสามารถให้กบัผิว Facet ได้
อีกด้วย  

 
สามารถเข้าถึงค าสัง่ได้ท่ี 

1. Home Tab > Create Box 

 

 
2. Command Finder พิมพ์ Create Box 
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Extrude Facet Body 
เป็นค าสัง่ใหม่ท่ีอยูใ่นหมวด Facet Modeling สามารถน า Facet Body มา Extrude ได้ 

 

  
 

สามารถเข้าถึงค าสัง่ได้ท่ี 

1. Reverse Engineering Tab > Extrude Facet Body 

 
 

2. Command Finder พิมพ์ Extrude Facet Body 
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Extrude Profile 
เป็นค าสัง่ใหม่ท่ีอยูใ่นหมวด Facet Modeling ซึง่จะลกัษณะของผลท่ีได้ เป็นแบบเดียวกบัค าสัง่ 

Create Box  

โดยจะมีวิธีการใช้งานคือ Extrude เส้นปิดให้ออกมาเป็นกลอ่ง 4 เหลีย่ม เพื่อครอบเส้นพอดี 

 
สามารถเข้าถึงค าสัง่ได้ท่ี 

1. Reverse Engineering Tab > Extrude Profile 

 
2. Command Finder พิมพ์ Extrude Facet Body 
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Snap Point enhancement 
 

ได้มีการเพิ่ม Point on Facet Vertex  ใน Snap Point เพื่อให้สามารถเลอืกจุดบนผิว Facet 
ได้  

โดยค าสัง่ท่ีจะมี Point on Facet Vertex มีดงันี ้

 Point 

 Line 

 Arc/Circle 

 Lines and Arcs 

 Studio Spline 

 Fit Curve 

 Four Point Surface 

 Rapid Surfacing 

 

สามารถเข้าถึงค าสัง่ได้ท่ี 

 Snap Point Bar 
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Merge Disjoint Facet Bodies 
เป็นค าสัง่ท่ีใช้ส าหรับท าการเช่ือมตอ่ผิวระหวา่ง Facet 2 ผิวเข้าด้วยกนัในลกัษณะท่ีมี Gap  ซึง่ 

Facet ทัง้ 2 ผิวนัน้ จะต้องเช่ือมตอ่กนัแบบ Linear หรือ Tangent  

 
 

 

Merge Overlapping Facet Bodies 
เป็นค าสัง่ท่ีใช้ส าหรับท าการเช่ือมตอ่ผิวระหวา่ง Facet 2 ผิวเข้าด้วยกนัในลกัษณะท่ีมี Overlap  
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Merge Touching Facet Bodies 
เป็นค าสัง่ท่ีใช้ส าหรับท าการเช่ือมตอ่ผิวระหวา่ง Facet 2 ผิวเข้าด้วยกนัในลกัษณะท่ีขอบของ 

Facet ทัง้ 2 นัน้สมัผสักนัพอดี หรือใช้ขอบเดียวกนั 

  
 
สามารถเข้าถึงค าสัง่ทัง้ 3 ได้ท่ี  

1. Reverse Engineering Tab   

 

 
2. Command Finder  

 
 
 
 
 
 
 
 
 
 



37 
 

www.facebook.com/dtmthailand  www.dtm-thailand.com 

Shape Studio 
 

Smooth Curve String 

Smooth Curve String  เป็นค าสัง่ท่ีใช้ส าหรับปรับเส้น Curve ท่ีไม่ตอ่เน่ือง, มี Gap และ ไม่ 
Smooth ให้เป็นเส้น Curve ท่ีรวมเป็นเส้นเดียว 

  
 

สามารถเข้าถึงค าสัง่ทัง้ได้ท่ี  
1. Curve Tab > Edit Curve > Smooth Curve > String 

 

 
2. Command Finder  พิมพ์ Smooth Curve > String 
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Section surface user interface improvements 
NX9.0 ได้มีการปรับปรุงค าสัง่ Section Surface ใหม่ โดยจากเดิมจะมีค าสัง่ให้เลอืกใช่ถึง 20 แบบ 

ปรับลดเหลอื 4 แบบ คือ Conic , Circular , Cubic , Linear เพื่อให้งา่ยตอ่การเลอืกน าไปให้งาน  โดย
สามารถเปรียบเทียบแบบเก่าและแบบใหม่ได้จากตารางด้านลา่ง 

 

 

 

 

 

 

 

 

 

Old Type New Type Mode Slope Control 

Ends-Apex-Shoulder Conic Shoulder By Apex 

Ends-Slope-Shoulder Conic Shoulder By Curves 

Fillet-Shoulder Conic Shoulder By Faces 

Ends-Apex-Rho Conic Rho By Apex 

Ends-Slope-Rho Conic Rho By Curves 

Fillet-Rho Conic Rho By Faces 

Ends-Apex-Hilite Conic Hilite By Apex 

Ends-Slope-Hilite Conic Hilite By Curves 

Fillet-Hilite Conic Hilite By Faces 

Four-Point-Slope Conic Four Point Slope N/A 
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Old Type New Type Mode Slope Control 

Five-Point Conic Five Point N/A 

Three-Point-Arc Circular Three Point N/A 

Two-Point-Radius Circular Two Point Radius N/A 

End-Slope-Arc Circular Two Point Slope N/A 

Point-Radius-Angle-Arc Circular Radius Angle Arc N/A 

Circle Circular Center Radius N/A 

Circle-Tangent Circular Tangent Radius N/A 

Ends-Slope-Cubic Cubic Two Slopes N/A 

Fillet-Bridge Cubic Fillet Bridge N/A 

Linear-Tangent Linear N/A N/A 
 

สามารถเข้าถึงค าสัง่ทัง้ได้ท่ี  
1. Curve Tab > Edit Curve > Smooth Curve > String 

 

 

2. Command Finder  พิมพ์ Smooth Curve > String 

 



40 
 

www.facebook.com/dtmthailand  www.dtm-thailand.com 

Assemblies 
 
Pattern Component 

เปลีย่นแปลงค าสัง่ Array Component Array ไปเป็น Pattern Component เพื่อให้งา่ยตอ่การใช้
งาน เพราะได้มีการท าให้มีรูปแบบเดียวกบัค าสัง่ Pattern Feature และ Pattern Face 

 

 

 

   

 

ผู้ใช้งานสามารถเลอืกลกัษณะการท า Pattern ได้ 3 แบบดงันี ้

 Linear – แบบตามแนวแกน 

 Circular – แบบวงกลม 

 Reference – อ้างอิงตาม Pattern ท่ีมีอยูแ่ล้ว 

NX8.5 

NX9.0 
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ในกรณีท่ีไม่เปิด Option : Associative ผู้ใช้งานจะสามารถเลอืกใช้รูปแบบอ่ืนเพิ่มได้อีก ดงันี ้

 Polygon – แบบหลายเหลีย่ม 

 Spiral – แบบก้นหอย 

 Along – แบบตามเส้นอ้างอิง 

 Helix – แบบเส้นสปริง 

 General – แบบก าหนดเอง 

 

 

 

 
สามารถเข้าถึงค าสัง่ทัง้ได้ท่ี  

1. Assembly Tab > Component Group > Pattern Component 

 
2. Command Finder > Pattern Component  
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Align/Lock assembly constraint  

NX9.0 ได้มีการเพิ่ม Assembly Constraint ขึน้มาใหม่อีก 1 แบบ คือ Align/Lock  โดย 
Constraint นีจ้ะมีการท าเหมือนกบั Constraint แบบ Touch/Align แตเ่ม่ือใช้ Align/Lock แล้ว ชิน้งานจะ
ไม่สามารถหมนุรอบแกนได้ 

 จากตวัอยา่งด้านลา่ง Bolt ด้านซ้ายเป็นแบบ Touch/Align ชิน้งานยงัคงสามารถหมนุรอบแกนท่ี
ท า Align ไว้ได้  แต ่ Bolt ด้านขวาเป็นแบบ Align/Lock เม่ือใช้แล้วชิน้งานจะ Fix อยูก่บัท่ี ไม่สามารถหมนุ
ได้ 

 
 
สามารถเข้าถึงค าสัง่ทัง้ได้ท่ี  

1. Assembly Tab > Component Position Group > Assembly Constrains 

 
2. Command Finder > Assembly Constrains 
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Drafting 
 

Preference and settings 
 

NX9.0 ได้มีการปรับเปลีย่นการตัง้คา่ตา่งๆ ของการบอกขนาดใหม่ โดยจากเดิมใน Version NX8.5 
จะต้องเข้าไปตัง้คา่ที่ Preferences > Annotation หรือ drawing preferences 

 
 

แตใ่น NX9.0 นัน้ต้องเข้าไปท่ี Tab ของ 2D Layout จากนัน้เลอืก Edit Setting  

 
 

โดยคา่ Preference ทัง้หมดในหมวด Drafting เช่น Annotation , Drawing Preference , PMI , 
View Style จะอยูภ่ายในหน้าตา่งเดียวคือ Setting  

ซึง่ขึน้อยูก่บัวา่ผู้ใช้งานเลอืก Object อะไรเข้าไปในหน้าตา่ง Edit Setting  หรือผู้ใช้งานจะท าการ
คลกิขวาในสิง่ท่ีต้องการแก้ไข แล้วเลอืก Edit Setting ก็ได้ 

 

 

NX8.5 
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สามารถเข้าถึงค าสัง่ได้ท่ี 

Application Drafting 

Command Finder Edit Settings  

Graphics window 

Right-click a drafting object→Settings 

Select one or more drafting objects→Settings  

Part Navigator Right-click a drafting object→Settings 

 

Changing the style of existing annotation and drafting objects 

 NX9.0 ยงัได้เปลีย่นรูปแบบของการแก้ไข Annotation และ Drafting Object ดงัรูปด้านลา่ง 
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Creating and editing dimensions 

NX9.0 วิธีการสร้าง Dimension แบบใหม่คือ  โดยมาแทนท่ี แบบ Inferred Dimension ใน 
NX8.5  

Rapid Dimension   โดยในค าสัง่นีจ้ะประกอบไปด้วยค าสัง่ยอ่ยท่ีใช้บอกขนาด ดงันี ้

 Inferred . 

 Horizontal 

 Vertical 

 Point–to–Point 

 Perpendicular 

 Cylindrical 

 Radial 

 Diametral 
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และ  โดยเม่ือมีการแก้ไขโดยการ Double Click ท่ี Dimension ท่ีได้วางไว้แล้วนัน้ จะ
ปรากฎหน้าตา่งยอ่ย ท่ีได้รวมเอาลกัษณะของรูปแบบท่ีต้องการแก้ไขเอาไว้ เพือ่ให้ผู้ใช้งานสามารถแก้ไขได้
งา่ยและรวดเร็วขึน้  

ดงัรูปด้านลา่ง จะเห็นวา่ผู้ใช้งานสามารถ Drag Mouse ท่ีจุดตา่งๆบนเส้นบอกขนาด เพื่อแก้ไขได้เลย 
โดยจะมีการแสดงผลแบบ Rail-Time  
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ผู้ใช้งานสามารถเลอืกคลกิท่ีปุ่ ม Settings  เพื่อเปิดหน้าตา่งเพิ่มเติม ในการปรับตัง้คา่ที่เพิ่ม
มากขึน้  

 
 

 

Auto balloon leader placement 
NX9.0 สามารถให้ผู้ใช้งานสามารถท า Balloon โดยการเรียงในแนวตัง้ได้  
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สามารถเข้าถึงค าสัง่ได้ท่ี 

1. Home Tab > Table Group > Auto Balloon 

 
 

2. Command Finder > Auto Balloon 

 
 

Drafting symbols 
NX9.0 ได้มีการเพิ่มสญัลกัษณ์ Axis Intersection และ Symbols แบบใหม่เข้าไปไว้ใน GD&T  

และ Note 

  

 Approximate Dimension 

 Sphere 

 Left Pitch 

 Right Pitch 

 Left Taper 

 Right Taper 
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Datum leader enhancements 
NX9.0 ได้เพิ่มความสามารถในการก าหนด Datum โดยผู้ใช้งานสามารถ drag เพื่อวางต าแหนง่ของ 

Datum ได้หลากหลายต าแหนง่มากยิ่งขึน้  

o Circular and bolt circle centerlines. 

 

 
o Dimension and annotation leader lines. 

 
 
 
 
 
 
 
 
 



50 
 

www.facebook.com/dtmthailand  www.dtm-thailand.com 

What’s new NX9.0 CAM 

CAM general 
 
Notes in Manufacturing 
สามารถเพิ่มข้อมลูท่ีต้องการเข้าไปในแตล่ะ Operation ได้หลายบรรทดั 

 
หน้าตา่ง Notes สามารถเปิดใช้งานได้ในทกุ operation และจากการเลอืกใน Operation Navigator 

ภายในหน้าตา่ง Notes สามารถที่จะ cut, paste, copy, ใสข้่อมลูท่ีน ามาจากไฟล์ และสามารถ save 
ออกไปเป็นไฟล์ text ได้เช่นกนั 

Note สามารถเรียก mom_operation_notes เพื่อเรียก notes ออกไปใช้ใน post และ shop documents 
ได้ 

ท ำไมถึงควรใช้? 

คณุสามารถจดัเก็บข้อมลู NX CAM ในช่องของ notes เช่น ความคิดเห็น ค าแนะน า หรือประวติัการแก้ไข 
ซึง่สามารถที่จะเรียกออกไปยงั post และ shop documents ได้ 
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สำมำรถเรียกค ำส่ังได้ที่ 

 

Application Manufacturing 

Command Finder Notes  

Menu Tools→Operation Navigator→Object→Notes 

Operation Navigator Right-click an operation→Notes 

 
 
 
Descriptions in Manufacturing 
  

คณุสามารถเพิ่ม Description ในทกุ program, operation, geometry group หรือ method ซึง่ 
Description สามารถเรียกดไูด้ทัง้ views ของ operation navigator 

 
จากก่อนหน้านี ้Description box ตามคา่ default จะแสดงอยูใ่นหน้าตา่งของ tool การแสดง 

Description ในหน้าตา่งของ operation ผู้ใช้งานจะต้องท าการ customize เรียก dialog box 

Note สามารถเรียก mom_operation_description, mom_geometry_description, 
mom_method_description, mom_program_description, mom_operation_notes เพื่อเรียก 
ออกไปใช้ใน post และ shop documents ได้ 

ท ำไมถึงควรใช้? 

เป็นประโยชน์ส าหรับการเพิ่มรายระเอียดในแตล่ะ Operation 
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Displaying visible and hidden geometry 
NX CAM สามารถแสดง geometry ท่ีช่อนอยูใ่นลกัษณะการแสดงทัง้ผิวและขอบได้ในเวลา

เดียวกนั โดยระยะเวลาในการแสดงรวดเร็วกวา่ในเวอร์ชัน่ก่อน 

Before 

 

After 

 

Note จาก geometry group หรือ operation dialog การแสดง geometry จะแสดงสขีอง blank พร้อมกบั 
translucency แสดงความโปร่งแสงของวตัถุ  

 

สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Prerequisite 

Some or all of the solid geometry selected for the CAM 
object is hidden. 

Operation Navigator Select the CAM object and display its geometry. 

Operation or Geometry group in the 
dialog box Select the Display button for the geometry type. 
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Boundary selection enhancements 
 

สว่นมาก แตไ่ม่ทัง้หมดของ Milling operations การก าหนด boundaries ในตอนนีเ้ก่ียวข้องกบั
การเลอืกชนิดของ  geometry ซึง่จะมีการเปลีย่นแปลงดงันี ้

 เปลีย่นการแสดงการเลอืก และ gap closing 

 เปลีย่นออปชัน่เป็น Tool Side แทนท่ีออปชัน่ Material Side  

ใน interface แบบเก่าจะใช้ออปชัน่ Material Side ก าหนดด้านของ boundary เพื่อเหลอื 
material ไว้ โดย NX ได้มีการปรับปรุงให้ใช้เป็นลษัณะ Tool Side แทน 

 ใน interface รูปแบบใหม่รองรับ journaling 

 

 

Enhanced selection display 

คณุสามารถมองเห็นแตล่ะ boundary segment ท่ี projected ไปยงั boundary plane เม่ือท าการ
เลอืก boundary segment 

NX จะท าการปิด gaps ของ boundary ให้อตัโนมติั เม่ือท าการเลอืก boundary segmentsการ
แสดงผลชดัเจนขึน้ด้วยการแสดงบน boundary plane และการ projection ไปตามทิศทางที่ต้องการ 

1 Boundary section label 

2 Boundary plane 

3 Boundary projection vector 
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คณุสามารถก าหนดสว่นตา่งๆดงันีไ้ด้งา่ยขึน้ start point, end point, boundary direction และ 
tool side ระหวา่ง boundary 

Boundary selected: 

1 Start point 

2 Tool side indicator (left) 

3 Direction arrow 

4 Tool position indicator (Tanto) 

5 End point 

 

การแสดงผลกราฟฟิกรวมถึงการใช้ custom offsets ของ boundary และของแตล่ะขอบเขต
ภายใน boundary ด้วย 

Boundary member selected: 

1 Section label 

2 Custom boundary Offset input box 

3 Custom boundary Member Offset input box 

4 Selected boundary member 
 

 

กำรใช้งำน 

Boundary user interface รูปแบบใหม่ สามารถใช้ได้ในงาน milling เม่ือท าการใช้งานดงัตอ่ไปนี ้

 ก าหนด part, blank, check หรือ trim boundaries ภายใน Mill Bnd geometry group 

 ก าหนด trim boundaries ภายใน Mill Area geometry group 

 ก าหนด trim boundaries ภายใน Floor Wall, Plunge Milling, Cavity Milling, Zlevel, Zlevel 
5axis, และ surface contouring operations 

 ก าหนด blank และ check boundaries ภายใน Floor Wall operation 
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Interface รูปแบบเดิมยงัคงถกูใช้กบัการก าหนด boundaries ภายใน Milling บางสว่น และทัง้หมด
ของงาน Turning และ Wire EDM เม่ือท าการสร้าง boundaries ด้วยรูปแบบเก่า ในขณะนี ้NX จะท าการ
ปิด gaps ให้อตัโนมติั เม่ือท าการเลอืก boundary segments 

 

ตวัอยา่งหน้าตา่ง boundary ใหม่ ตวัอยา่งหน้าตา่ง boundary เดิม 
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สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Command 
Finder Create Geometry  

Location in 
dialog box 

[Milling operation] dialog box→Geometry group→Create New  

Create Geometry or New Geometry dialog box→Type list→mill_planar, 

mill_contour, mill_multi-axis→Geometry Subtype group→MILL_BND  

 
Boundary selection display and gap closing 

NX จะปิด gaps ของ boundaries ให้อตัโนมติั และแสดงผล ช่วยให้รู้ผลลพัท์ของขอบเขตทนัที
เม่ือท าการเลอืก boundary segments โดยคา่เบือ้งต้น NX จะตัง้คา่การปิด gaps เป็น extend boundary  

 

Boundary display with gaps 

Connect to Next Member = Extend 

Member 1 

Member 2 

จากตวัอยา่งนี ้การเลอืกแบบ direct connection เป็นการเลอืกท่ีดีกวา่ ซึง่สามารถเลอืกเปลีย่นได้ตามนี ้

1. ในหน้าตา่ง Part Boundaries ใน Members group ในแถบของ list เลอืกMember 1 

2. จาก Connect to Next Member list เลอืกเปลีย่นเป็น Direct 

 

Boundary display with gaps 

Connect to Next Member = Direct 
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Pasting operations with reference 
คณุสามารถ copy operations จาก workpiece หนึง่ และ paste ในลกัษณะ with reference ไป

ยงั workpiece อ่ืนๆ ด้วยการใช้ออปชัน่ Paste Inside with Reference  

รูปภาพด้านลา่งแสดง operations และการ copy แบบอ้างอิงกนัของ operation หลกั
(WORKPIECE_1) และ paste ไปยงัท่ีมาอ้างอิง (WORKPIECE_2) 

 
Name Path Dependencies 
GEOMETRY   

Unused Items   

MCS_MAIN   

WORKPIECE_1   

MCS  
 

MILL_CONTROL   

FLR_WALL_TOP   

FLR_WALL_WALL   

CAVITY_MILL   

DRILLING   

MILL_BND  
 

WORKPIECE_2   

MCS_1  
 

MILL_CONTROL_1   

FLR_WALL_TOP_1   

FLR_WALL_WALL_1   

CAVITY_MILL_1   

DRILLING_1   

MILL_BND_1  
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รองรับการเลอืก geometry ดงัตอ่ไปนี ้

 MCS 

 MILL_AREA 

 MILL_BND 

 HOLE_BOSS_GEOM 

 DRILL_GEOM 

 MILL_GEOM 

ออปชัน่ Paste inside with Reference จะสามารถใช้ได้ทัง้หมดกบั milling and drilling 
operations 

สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Prerequisite 

A supported milling or drilling operation 

The part geometry defined in the workpiece objects must originate from the 
same assembly component 

Command 
Finder Paste with Reference 

Menu Tools→Operation Navigator→Paste with Reference 

 

 

Show Thickness by Color enhancements 
คณุสามารถก าหนด fringe plot ในหน้าตา่ง Show Thickness by Color ด้วยวิธีดงันี ้ 

 ระบุตวัเลขส ีซึง่คณุสามารถก าหนดได้ถึง 8 ส ี

 ตัง้คา่ต าสดุ และสงูสดุในการเช็ค fringe plot ส าหรับแตล่ะช่วงความหนา 

 Set precise range divisions to control the plot color for each defined range. 
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ตวัอยา่งตอ่ไปนีเ้ป็นการแสดง fringe plots และการวดัระยะจากชิน้งาน 

 

  

เป็นการแสดงความ
หนาของเนือ้ท่ีเหลอื 
เช่น ในงาน semi-
finish ซึง่คณุ
สามารถตัง้คา่ต ่าสดุ 
และสงูสดุ ใน NX 
เพื่อก าหนดก าหนด
ขอบเขตท่ีต้องการ
แสดง 

  

ในบางครัง้ NX จะ
แสดงสี่ตามคา่
เบือ้งต้นของ Blank 
ในแตล่ะพืน้ท่ี ตาม
ตวัอยา่งจะแสดง
ตามคา่สขีองผิด
ด้านบนของ Blank 



60 
 

www.facebook.com/dtmthailand  www.dtm-thailand.com 

  

ความตา่งของช่วง
ขนาดท่ีเหลอื 
สามารถระบุให้แคบ
ลง เพื่อให้มองเห็นสี
ท่ีแตกตา่งกนัได้
ชดัเจนขึน้ 

  
  

ในการก าหนดจุดเช็ค คณุสามารถคลกิบนภาพตามต าแหนง่ท่ีต้องการ ซึง่จะเป็นการแสดงคา่ที่เหลอื
ระหวา่ง IPW facet ไปถึง part surface. 

  

 

  
  

ท ำไมถึงควรใช้? 
คณุสามารถเช็คคา่ความหนาที่เหลอืหลงัการการท างานในแต่ละ operation ได้งา่ย และถกูต้องมากขึน้ 
สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Operation 
Navigator 

Right-click a program or operation→Tool Path→Verify→Tool Path 

Visualization dialog box→3D Dynamic tab→Show Thickness by Color 

Location in 
dialog box 

[Setting number of ranges] Define Ranges group 

[Defining range limits] Range Colors and Limits group 
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Set Machining Data enhancements 
คา่ Cut depth และ stepover ในขณะนีมี้ออปชัน่ให้เลอืก ส าหรับการก าหนดคา่ใน machining 

data record  

Machining Data library 

เม่ือท าการคลกิ OK ในหน้าตา่ง Edit Machining Data Record คา่ที่ออกมาขึน้อยกูบัวา่ คณุได้ตัง้
คา่หรือไม่  

 ถ้าคณุเลอืกตัง้คา่ไว้ NX จะออกคา่ไปตามคา่ที่ระบุไว้ใน machining record  

การเลอืกตัง้คา่ ท าได้โดยเลอืก Cut Depth or Stepover  ไว้  

 ถ้าคณุไม่ต้องการตัง้คา่ไว้ NX จะออกคา่ machining record เทา่กบั -1 ใน columns ของ Cut 

Depth และStepover ซึง่คา่ -1 จะเป็นการบอกลกัษณะท่ีไม่มีการตัง้คา่ใน NX นัน่เอง  

LIbref Diameter Length Cut Depth Stepover 

THSO_00... 2.5 7.5 -1 -1 

THSO_00... 3 9 .3 .3 

THSO_00... 4 12 .4 .4 

 

Set Machining Data 

เม่ือคณุปรับคา่ machining data ใน operation ถ้า NX พบวา่คา่เป็น -1 ใน library ของ Cut 

Depth หรือ Stepover คา่จะไม่ถกูน ามาเปลีย่นใน operation 
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สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Command 
Finder Edit Machining Data Libraries 

Location in 
dialog box 

Specifying Machining Data library values: 

Edit Machining Data Libraries dialog box→Machining Data tab→Insert or 
Modify 

Setting machining data for an operation: 

[Operation] dialog box→Feeds and Speeds →Feeds and Speeds 

dialog box→Automatic Settings group→Set Machining Data  

Operation 
Navigator 

Setting machining data for an operation: 

Right click an operation→Object→Set Machining Data 

 

 

Flute length for drills 
ในตอนนีส้ามารถใสค่า่ (FL) Flute Length ส าหรับ center drills, spot drills และ countersinks 

ได้ และคา่ความยาวจะแปลผนัไปตามขนาด diameter และ angle 

ซึง่ถ้าคณุต้องการใสค่า่ความยาวที่ตา่งออกไป สามารถเพิ่ม (FL) Flute Length มายงัไดอลอก
บล๊อกของ Tool โดยเปิดท่ี Customize ได้ ซึง่คณุสามารถใสค่า่ความยาวได้ตามต้องการ 

Pre-NX 9 NX 9 
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ท ำไมถึงควรใช้? 

ใช้คา่ Flute length เพื่อความถกูต้องของการเช็คการชน และการใช้ gouge checking ในระหว่างการ
จ าลองการกดั 

สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Operation Navigator Right-click tool node→Object→Customize 

 

Milling enhancements 

Machining with a T-Cutter 
ในขณะนี ้NX รองรับการท างานในรูปแบบงาน slots, grooves และการน าขอบด้านลา่งมาใช้ในการ

กดั ด้วยค าสัง่ใหม่ T-Cutter. 

 T-Cutter tracking point control. 

 
 Operation ใหม่ในการท างาน Tslot ช่วยเพิ่มปรสทิธิภาพในการท างาน slots ในแนวเส้นตรงได้ดี
ขึน้ 

 
 การวางต าแหนง่, การเลอืก geometry, การเข้า และออกงาน จะใช้รูปแบบเช่นเดียวกบัการใช้ 

Fixed Contour และใช้ขอบเขตในการท างาน  
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      Fixed contouring operations 

 
เม่ือคณุใช้ขอบเขต Boundary ในการท างาน กบั Fixed Contour operations คณุสามารถท าตาม

ขัน้ตอนได้ดงันี ้

 ใช้ต าแหนง่ขอบด้านบนในการกดั T-Cutter ส าหรับรูปร่างที่เป็น under cut ซึง่ท างานได้ทัง้ผิวเรียบ 
และผิวโค้ง โดยการมองแนวแกน tool ขึน้ด้านบนแล้ว project ขึน้ไป ด้วนการใช้ค าสัง่ใหม่ Tool Axis 

Up ใน projection vector. 

Note  Tool Axis Up ใน projection vector สามารถใช้ได้ในค าสัง่ของ variable-axis surface 
contouring operations ด้วย 

 เลอืก solid หรือ sheet body ใน part geometry และ project boundary curves เพื่อสร้างแนว
การท างานให้กบั operation. 

 ระบุคา่ที่ต้องการยืดออกของ engages และ retract moves 

NX จะใช้ neck และ shank clearance เพื่อตรวจสอบการเช็คการชนให้ด้วย 

 

Drive geometry boundary curves 

เลอืกผิวเพื่อก านหนด part geometry และ project edge curves ไปยงั plane เพื่อสร้างแนวของ
ขอบเขต เม่ือท าการ generate โดยใช้ออปชัน่ Tool Axis Up แนวของขอบเขต จะถกู projects ขึน้ไปตาม
แนวแกนไปยงั ขอบท่ีต้องการสร้าง tool path  
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1 Ledge faces selected 
as part geometry 

2 Boundary plane 

3 Drive boundary 

4 Tool path 
 

 

   

สามารถเลอืก sheet bodies เป็น part geometry และ project edge curves เพื่อสร้างขอบเขต
การกดัได้เช่นกนั 

1 Sheet body selected 
as part geometry 

2 Boundary plane 

3 Drive boundary 

4 Tool path 
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กำรยืดเส้น tool path ของ arc engage และ retract  

Linear extensions คือการยืด tool path ก่อน และหลงั arc engage หรือ retract moves การ
เคลือ่นท่ีทัง้สอง มีการเพิ่มออปชัน่ขึน้ใหม่ และมีการเปลีย่นช่ือเป็นดงันี ้

 ส าหรับ arc engage moves ในตอนนีเ้รียกวา่ Extend before Arc 

 ส าหรับ arc retract moves ในตอนนีเ้รียกวา่ Extend after Arc 

ออปชัน่นีจ้ะช่วยให้คณุสามารถก าหนดคา่ในการยืดท่ีแตกตา่งกนัได้ระหวา่ง before และ after ในการใช้ 
arc move 

 

 1 Open Area engage 

 Engage Type = Arc – Normal to Tool 
Axis 

 Extend before Arc = 0.7500 

 Extend after Arc = 0.5000 

 2 Final retract 

 Retract Type = Arc – Normal to Tool 
Axis 

 Extend before Arc = 0.6000 

 Extend after Arc = 0.9000 

จากท่ีใน Operations เดิม คา่ Linear Extension จะเป็นคา่เดียวท่ีใช้ก าหนดทัง้ Extend before 

Arc และ Extend after Arc ไปพร้อมกนั 

สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Prerequisite You must use a Fixed Contour operation with the Boundary drive method. 

Location in dialog 
box 

Drive Method group→Method list→Boundary→Edit →Boundary 

Drive Method dialog box 
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Groove Milling operation 
ใช้ Groove Milling operation กบัการกดัลองในแนวตรง เช่น grooves, slots และรูปร่างที่ใช้ T-

Cutters การท างานจะท างานเป็นลกัษณะกดัเป็นชัน้ๆเข้าไป และเปลีย่นแปลงหาจุด tracking point เพื่อ
กดัจากด้านบนลงด้านลา่งให้อตัโนมติั คณุสามารถใช้ความสามารถในการกดัในลกัษณะ multiple เพือ่ท า
การกดั rough และ finish ได้ 

 
Groove geometry 

เม่ือคณุก าหนด Groove geometry โปรแรมจะท าการสร้างชิน้งานท่ีจะเป็นเนือ้ของร่องขึน้มา ซึง่
คณุสามารถที่จะ 

 ก าหนดพืน้ท่ีการกัดจากการเลอืกค าสัง่ Groove Geometry  หรือดงึคา่ของร่องจาก feature 
group 

 แสดง in-process feature ส าหรับ operation 

 
 ควบคมุการค านวณ in-process feature โดยใช้ in-process workpiece  

o ท าการยืด in-process feature ไปยงัจุดสิน้สดุของ in-process workpiece ด้วยการเลอืก
ออปชัน่ Use 3D  
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o ท าการเลอืกเฉพาะวสัดใุนร่อง ให้ท าการเลอืกออปชัน่ None  

 
Cut levels and level sequencing 

เม่ือท าการก าหนดจ านวนของ cut คณุจะสามารถควบคมุล าดบัการกดัได้ด้วย ซึง่ cut levels จะแสดง
ขึน้มาช่วยให้คณุเห็นรูปแบบของล าดบัการกดั ซึง่ในตวัอยา่งจะมีการตัง้คา่ตามนี ้ 

 Level Sequencing = Center to Ceiling to Floor 

 Depth per Cut = Passes 

 Number of Passes = 3 

 
Preview  

 

Preview Display  
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สำมำรถเรียกค ำส่ังได้ที่ 

 

Application Manufacturing 

Command 
Finder Create Operation  

Location in 
dialog box 

Create Operation dialog box→Type list→mill_planar→Operation 

Subtype group→GROOVE_MILLING  

 
 
Groove Milling relief clearance 

ใช้ออปชัน่ Relief Clearance ในการก าหนดคา่ offset ท าให้เกิดชัน้บริเวณมมุ  

ตวัอยา่งด้านลา่งแสดง tool path ท่ีไม่มีการก าหนดคา่ Relief Clearance  

 
Tool path, Relief Clearance = 0 

 

 
Top pass, Relief Clearance = 0 

เม่ือคณุก าหนดคา่ Relief Clearance value ใน NX จะท าดงัตอ่ไปนี ้

1. ท าซ า้บริเวณมมุ รวมถึงการสร้าง cut direction ในสว่นของ floor หรือ ceiling pass และ wall  

2. Offsets คา่ floor หรือ ceiling pass ตามคา่ที่ระบุ 

3. Offsets คา wall pass ตามคา่ที่ระบุ 

4. ในล าดบัการกดั จะวา่งกดัร่องกลาง และไปกดัในสว่นของ floor หรือ ceiling pass ก่อน แล้วจึงกดั 
wall pass เป็นล าดบัสดุท้าย 
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ตามตวัอยา่ง มีการใสค่า่ Relief Clearance value เทา่กบั 1 mm ดงันัน้เราจะเห็นท่ีมมุเหลอืตามภาพ ซึง่
คา่ปกติท่ีใช้จะใช้ประมาณ 0.01 mm 

 สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Prerequisite Groove Milling operation using a T-Cutter tool 

Location in 
dialog box 

 [Groove Milling operation] dialog box→Path Settings 

group→Cutting Parameters →Cutting Parameters dialog 
box→Strategy tab→Avoid Recutting group 

 
 

T-cutter tracking points 
T-cutters มี 4 คา่ในการมอง tracking points คูณสามารถเลอืกจุดใดจุดหนึง่เพื่อท าการ drive ใน 

operation ของ Planar Profile 
 SYS_CL_Top และ SYS_CL_Bottom คือ tool centerline tracking points 
 SYS_OD_Top และ SYS_OD_Bottom คือtool contact tracking points 

 

SYS_CL_Top tracking point เป็นการดงึความสมัพนัธ์มาจาก tool 
center และ flute length เพ่ือใช้ในการวาง tool path 

SYS_OD_Top (R2) tracking point เป็นการดงึความสมัพนัธ์มาจาก 
tool diameter และ flute length เพ่ือใช้ในการวาง tool path 

SYS_OD_Bottom (R1) tracking point เป็นการดงึความสมัพนัธ์มา
จาก tool diameter เพ่ือใช้ในการวาง tool path 

SYS_CL_Bottom tracking point เป็นการดงึความสมัพนัธ์มาจาก 
bottom center ของ tool เพ่ือใช้ในการวาง tool path 
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NX แสดงช่ือ tracking point ไว้ใน Tracking Points dialog box 

ส าหรับ Planar Profile และ Groove Milling operations คณุสามารถเลอืกหนึง่ใน tracking points 
เพื่อปลอ่ยคา่ tracking data หรือคณุสามารถเลือก Contact Point เพื่อปลอ่ยคา่ contact data ซึง่ส าหรับ 
Groove Milling operations มีสองตวัเลอืกเพิ่มขึน้คือ 

 SYS_OD_Automatic เลอืก outer diameter tracking point ท่ีเหมาะสมให้อตัโนมติั 

 SYS_CL_Automatic เลอืก centerline tracking point ท่ีเหมาะสมให้อตัโนมติั 

 

สำมำรถเรียกค ำส่ังได้ที่ 
 

Application Manufacturing 

Prerequisite Planar Profile or Groove Milling operation using a T-Cutter tool 

Location in 
dialog box 

Tracking points: 

 Create Tool dialog box→Tool Subtype group→T Cutter→Milling 

Tool-T Cutter dialog box→More tab→Tracking group→Tracking 

Points→Tracking Points dialog box 

Output tracking data: 

 [Operation dialog box]→Path Settings group→Non Cutting Moves 

→Non Cutting Moves dialog box→More tab→Cutter Compensation 
group→Output Contact/Tracking Data →Tracking Data list 
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Planar Profile drive point control for T-cutters 
ใน Planar Profile operation คณุสามารถเลอืกจุดของ tracking points บน T-cutter เพื่อสร้าง 

drive point ซึง่การเลอืก tracking point จะท าให้การมองเป็นรูปแบบไม่สนใจ part geometry เพราะ part 
geometry จะถกูยกเว้น คณุจึงต้องก าหนดขอบเขตอยา่งระมดัระวงั เพือ่ป้องกนัการชน เม่ือคณุใช้ 
tracking point ในสว่นของ floor geometry จะไม่จ าเป็น และ ค าสัง่ Specify Floor  จะไม่สามารถดไูด้ 

 

1 Drive point 

2 Boundary geometry 

 

ท ำไมถึงควรใช้? 

เม่ือคณุเลอืกใช้งาน tracking point ในการสร้าง drive point คณุสามารถก าหนดต าแหนง่ของ T-cutter ใน
งาน under cut ได้งา่ยขึน้ 

สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Prerequisite Planar Profile operation using a T-Cutter tool 

Location in dialog 
box 

Planar Profile operation dialog box→Path Settings group→Drive 

Point list 

 
 
Groove Milling tracking point selection 

ส าหรับ Groove Milling operation ใน NX ใช้การเลอืก T-cutter tracking point ในการสร้าง 
drive point ให้กบั operation ซึง่คณุสามารถก าหนดคา่ tracking points ได้ตามนี ้

 SYS_CL_Top and SYS_CL_Bottom เป็นการเลอืก tracking points ตามแนว tool centerline  

 SYS_OD_Top and SYS_OD_Bottom เป็นการเลอืก tracking points ตาม tool contact 
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คณุสามารถเลอืกออปชัน่เป็น automatic Tracking Data เพื่อให้ NX ใช้จุด tracking point ท่ีเหมาะสมให้
อตัโนมติั เม่ือเป็นการกดัด้านบนของมีด จะใช้ tracking point ท่ีด้านบน เม่ือเป็นการกดัด้านลา่งของมีด 
จะใช้ tracking point ท่ีด้านลา่ง  

 SYS_OD_Automatic เลอืก outer diameter tracking point ท่ีเหมาะสมให้อตัโนมติั 
 SYS_CL_Automatic เลอืก centerline tracking point ท่ีเหมาะสมให้อตัโนมติั 

Tracking point ของ NX ขึน้อยูก่บัการเลอืกตอ่ไปนี ้และสามารถเปลีย่นระหวา่งชัน้การกดัได้  
 ออปชัน่ Output Contact/Tracking Data  
 การตัง้คา่ร Tracking Data  
 สถานท่ีของ tracking point  
 เป็นชัน้ด้านบน หรือด้านลา่งของ slot 
 ล าดบัของการกดั 

 

P1 = SYS_CL_Bottom 

P2 = SYS_CL_Top 

P3 = SYS_OD_Bottom 

P4 = SYS_OD_Top 

Output Contact/Tracking Data, Tracking Data = SYS_OD_Automatic 

 

 

 

Bottom up cutting sequence Top down cutting sequence Mixed cutting sequence 

Output Contact/Tracking Data, Tracking Data = SYS_CL_Automatic 

 

 

 

Bottom up cutting sequence Top down cutting sequence Mixed cutting sequence 
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สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Prerequisite Groove Milling operation using a T-Cutter tool 

Location in 
dialog box 

 [Operation dialog box]→Path Settings group→Non Cutting Moves 

→Non Cutting Moves dialog box→More tab→Cutter Compensation 
group→Output Contact/Tracking Data →Tracking Data list 

 
 
Cut region control for Area Milling 

ใช้ค าสัง่ Cut Regions  เพื่อแบง่พืน้ท่ีการกดัใน Area Milling operation ภายในแต่ละพืน้ท่ี 
สามารถควบคมุรูปแบบการกดัได้ จากท่ีเร่ิมแรก NX สามารถแบง่พืน้ท่ีการกดัได้จาก ความชนัของผิว และ
การตรวจสอบการชน ภายใน operation ซึง่ตอนนีค้ณุสามารถที่จะ 

 ขนาดของพืน้ท่ี ท าการรวม หรือแยกตามต้องการ ซึง่ NX จะท าการ update  และแสดงผลทนัที
เม่ือมีการแก้ไข 

 พืน้ท่ี และล าดบัการกดั ถ้ารูปแบบไม่เหมาะสมส าหรับการกดัในบางพืน้ท่ี คณุสามารถปรับปรุง 
และน าไปวางในท่ีท่ีเหมาะสม หรือในบางกรณีอาจท าการลบพืน้ท่ีนัน้ไป แล้วไปท ายงั operation อ่ืน
แทน 

 รูปแบบการกดั และพารามิเตอร์อ่ืนๆของ tool path ภายในแต่ละพืน้ท่ี คณุสามารถก าหนดพืน้ท่ี
เป็น steep, non-steep หรือ flat และ NX จะใช้คา่ที่เหมาะสมท่ีท าการตัง้คา่มาจาก and Area Milling 

Drive Method เข้ามาท างาน 
 ก าหนดจุดเร่ิมต้นในแต่ละพืน้ท่ี 
 Tool และการเอียงของ tool เม่ือเลอืกการเช็คการชนของ holder ในแต่ละพืน้ท่ี จะสามารถ
มองเห็น และสามารถ ใช้ tool ท่ียาวขึน้, ใช้ holder อ่ืน หรือเอียงแนวแกนของ tool เพื่อหลกีเลีย่งการ
ชน 
ก่อนหน้านี ้เม่ือคณุสร้าง operation ในรูปแบบ contour โปรแกรม NX จะตดับางพืน้ท่ีออก, วาง

รูปแบบการกดั และก าหนดจุดลงระหวา่งพืน้ท่ีให้อตัโนมติั โดยคณุไม่สามารถควบคมุได้วา่ในแตล่ะพืน้ท่ี
ต้องการรูปแบบใด ซึง่ในขณะนีค้ณุสามารถยอมรับคา่ในรูปแบบอตัโนมติัได้ หรือจะท าการก าหนด cut 
regions, cut patterns และ start points เพื่อให้เหมาะสมกบัการท างาน แทนการใช้งานในรูปแบบ
อตัโนมติัได้เช่นกนั 



75 
 

www.facebook.com/dtmthailand  www.dtm-thailand.com 

NX จะด าเนินการตอ่ไปนีอ้ตัโนมติั 
 แสดงพืน้ท่ีการกดัท่ี ถกูต้อง valid , ไม่ถกูต้อง invalid , หรือ ไม่สามารถท างานได้ out of 

date  
Cut region จะขึน้เป็น invalid ถ้าคณุเปลีย่นแปลง operation parameter ท่ีก าหนดใน region 
ตวัอยา่งเช่น ถ้าคณุเปลีย่นไปใช้ tool อ่ืน, Cut region จะขึน้เป็น out of date ถ้าคณุเปลีย่นแปลง 
parameter โดยการแก้ไข region ตวัอยา่งเช่น ถ้าคณุเปลีย่นคา่ part stock 

 บง่บอกวา่มีการชนภายใน collisions  หรือไม่มีการชน collision-free  
ถ้าคณุไม่ได้มีการเช็คการชน collision, NX จะบอกลษัณะการตรวจการชน collision เป็น  
ถ้าคณุเช็คการชน collision และบางสว่นมีการชน จะแสดงลกัษณะเป็น  

 สามารถตัง้คา่ cut region เป็น steep , non-steep , or flat . 
ตามตวัอยา่งนี ้cut regions ท่ี 2, 3, 5, และ 6 เป็น cut regions ท่ีสามารถท างานได้ปกติ สว่น Cut 
regions ท่ี 1 และ 4 จะมีการชนของ holder และจะท าการตดั cut regions ออกเพื่อไว้ส าหรับสร้างใน 
operation อ่ืน  

Name Status Cut Order Type 
Collision 
Status 

Parent Operation 

REGION_1 

REGION_2 

REGION_3 

REGION_4 

REGION_5 

REGION_6 

 

 

 

 

 

 

1 

2 

3 

4 

5 

6 

 

 

 

 

 

 

 

 

 

 

 

 

CONTOUR_AREA 

CONTOUR_AREA 

CONTOUR_AREA 

CONTOUR_AREA 

CONTOUR_AREA 

CONTOUR_AREA 
 

Cut Regions list example 

 

Cut Regions graphics display 
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ท ำไมถึงควรใช้? 
ออปชัน่ใหม่ Cut Regions จะชว่ยให้คณุท างานได้อยา่งมีประสทิธิภาพ และควบคมุการกดับน

ชิน้งานได้ตามต้องการมากขึน้ ซึง่คณุสามารถแสดง cut regions, ปรับปรุงการกดั และ tool path ให้ดี
ยิ่งขึน้ได้ 

สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Prerequisites 

You need a fixed-axis surface contouring operation using the Area Milling 
drive method, or a Contour Area operation. 

A ball-nose mill is required to change the tool axis. 

The non-steep Stepover Applied option must be set to On Plane. 

To generate the tool path, you must turn off the Multi-Depth Cut cutting 
parameter option. 

Location in dialog 
box 

[Surface contouring operation] dialog box→Geometry group→Cut 

Regions  

 
Creating cut regions 

ใช้ค าสัง่ Create Region List  ในการแบง่ cut area ให้อตัโนมติั ซึง่จะแบง่ได้ตามลษัณะดงัตอ่ไปนี ้

 ขึน้อยกูบัความชนัของผิววา่ มากกวา่ หรือน้อยกวา่ Steep Angle ท่ีก าหนดใน operation 

 
Steep Angle = 45 
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 จากการก าหนดความชนัของผิว จะท าการแยกผิวที่เป็นผิวเรียบออกมตามรูป  

 
Steep Angle = 45 

 จากการเช็ค tool holder collisions 

คณุจะต้องเปิด collision checking ใน operation คือเลอืกเปิด Cutting 

Parameters→Containment tab→Collision Checking group→Check Tool and Holder  

 
Steep Angle = 45 

 
Controlling the tool path in cut regions 
คณุสามารถควบคมุ tool path ใน cut region ได้ตามนี ้

 ก าหนด custom start point เลอืกจุดเร่ิมต้นในการลงของแตล่ะ region โดยเลือ่กค าสัง่ Edit  
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1 Default region start point 

 
2 Specified region start point 

 เม่ือคณุตัง้คา่ Containment Type เป็น Steep , Non-steep  หรือ Flat ,  NX จะใช้คา่ 
cut pattern, cut direction, stepover และ cut angle ท่ีตัง้ไว้ใน Area Milling Drive Method  

 ในแถบ Preview สามารถคลกิ Display เพื่อดรููปแบบการกดั cut pattern ได้ 

  
 เลอืก tool ท่ีมีขนาดยาวมากกวา่ เพื่อไม่ให้เกิดการชนของ holder โดยใช้ค าสัง่ Tool Collision 

Avoidance  

 
Preview display of shorter tool shows 
collisions. 

 
Preview display of longer tool shows no 
collisions. 
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 ปรับมมุเอียงของแนวแกน tool เพื่อเลีย่งการชนของ holder โดยใช้ค าสัง่ Tool Collision 

Avoidance  

 
Preview display of tool shows collisions. 

 
Preview display with 5 degree tilt shows no collisions. 

ถ้าบางสว่นของ cut region มีการชน คณุสามารถท่ีจะใช้ค าสัง่แบง่พืน้ท่ี Divide  เพื่อแยกพืน้ท่ีท่ีมีการ
ชนออกมา ซึง่จะช่วยให้คณุสามารถน ามาเปลีย่นความยาว tool หรือปรับแนวแกน tool เพื่อหลกีเลีย่งการ
ชนได้ตอ่ไป 
 
Managing cut regions 
จดัการ cut regions ได้ตามรูปแบบตอ่ไปนี ้

 การลบ regions โดยการใช้ค าสัง่ Delete All Regions  หรือเลอืกแตล่ะ regions แล้วเลอืก 
delete 

 ตรวจสอบวา่มีลกัษณะเป็น out of date หรือไม่ ถ้ามี region ท่ีเป็น out of date ให้ท าการลบ
ทกุ region ออก และท าการสร้าง region list ขึน้ใหม่ 

 การแสดง cut regions เลอืกเส้นใน region จะท าการแสดงเส้นทัง้หมดท่ีอยูใ่น cut region และ
เม่ือเลอืก Preview  จะแสดง region start point และ tool axis vector 

 
Preview  
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Preview 

 ข้าม region เพื่อไปท างานใน Area Milling operation อ่ืน หรือลบ region เพื่อไปท างานใน Area 
Milling operation อ่ืน เม่ือเลอืกในลกัษณะ  การท างานใน regions นัน้ๆจะท างานปกติ เม่ือเลอืกใน
ลกัษณะ  จะข้าม region นัน้ไปในการ generate  

 
1 Flat regions are deferred 
2 Flat regions are deleted 
การกดัในพืน้ท่ีท าท าการข้าม deferred regions ไว้ โดยการคดัลอก Area Milling operation และวาง
เพื่อสร้างเป็น operation ใหม่ คณุสามารถแก้ไข regions ใน operation ใหม่ เม่ือ import ในสว่นท่ี
ข้ามเข้ามา  

 การเลอืก import region เข้ามาใน operation ใหม่ ตามตวัอยา่งจะเป็นการ import ในสว่นของ 
flat regions ท่ีท าการข้ามไว้ใน operation ก่อนหน้านี ้

Cut Regions dialog box settings Result 

Region Source group: 

o Create From = 
Import 

Filter Deferred Regions group: 

o Program = All 

o Steep Type = Flat 

o Status = Deferred 
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 นอกจากนีก้ารแบง่ cut regions โดยใช้ค าสัง่ Divide  คณุสามารถที่จะแบง่ region โดย
ก าหนด plane หรือก าหนดจุดสองจุดในการสร้างเส้นแบง่ได้  

 
 การรวม cut regions โดยใช้ค าสัง่ Merge Cut Regions  ด้วยการเลอืก region หล้กแล้ว
เลอืก regions อ่ืนท่ีต้องการรวม ซึง่ region หลกัจะเป็นตวัควบคมุลกัษณะของ steep, non-steep, 
หรือ flat ให้ 

 
1 Non-steep target region, 2 Steep tool region, 3 Non-steep merged region 

 

 
1 Steep target region, 2 Non-steep tool region, 3 Steep merged region 

 การเรียงล าดบั cut region โดยปกติ NX จะเรียง steep regions ก่อน non-steep regions ถ้าแบง่
ออกมาเป็น flat regions จะเรียงเป็นล าดบัสดุท้าย 

 สามารถเปลีย่นช่ือ region ได้ 
 Undo changes คณุสามารถเลอืก undo ได้ตลอดเวลา แตจ่ะไม่สามารถ undo ได้ หลงัจากท่ีปิด
หน้าตา่ง Cut Regions ออกไปแล้ว 
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Area Milling drive method enhancements 
มีออปชัน่ใหม่ส าหรับ steep containment และ cutting ใน Area Milling operations โดยใช้ Steep และ 
Non-steep steep containment ในรูปแบบการกดัในรูปแบบ  Zlevel Zig, Zlevel Zig Zag หรือ Zlevel 

Zig Zag with Lifts และ Directional Steep ยงัคงมีให้ใช้งานอยูเ่ช่นเดียวกบัในเวอร์ชัน่ก่อนหน้านี ้

 
Method = Directional Steep 
Steep Angle = 35 

 
Method = Steep and Non-steep 
Steep Angle = 35 

คณุสามารถสร้างขอบเขตท่ีเป็น flat แยกออกมาได้ 

 
Create Separate Regions For Flat Areas 

 
Create Separate Regions For Flat Areas 

 
 
Divide By Holder 
ใช้ค าสัง่ Divide By Holder ในการเก็บงาน semi-finishing หรือ finishing โดยการแบง่ tool path ด้วยการ
ข้ามจุดท่ีเกิดการชน ซึง่คณุสามารถแบง่ tool path ได้จากความยาว tool ท่ีแตกตา่งกนั และ tool holder ท่ี
แตกตา่งกนั แตมี่การใช้ขนาด diameter และรูปร่างของ tool ท่ีเหมือนกนั หลงัจากท าการแยกเรียบร้อย
แล้ว สามารถท าการแก้ไข และ regenerate ได้  
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Initial Surface Contouring operation Tool path divided into 3 using Divide by Holder  

Divide by Holder paths 

   

Shortest tool Medium length tool Longest tool 

ค าสัง่ Divide by Holder ช่วยให้คณุสามารถเลอืก tools และก าหนด parameter ในการแบง่ tool path  
โดยคณุสามารถตดั และวางใน part เดียวกนั หรือท าเป็น template แล้วน าไปใช้กบั part อ่ืน ซึง่จะยงัคง
คา่ข้อมลูตามการใช้ divided holder ดงัเดิม  

เม่ือใช้การกดัในรูปแบบ Zig cut pattern คณุสามารถก าหนดคา่ overlaps, minimum cut length และ 
other controls โดยใช้ออปชัน่ Divide at Collision ซึง่ operation นีจ้ะอ้างอิง geometry และ check 
geometry แตจ่ะไม่สนใจ Blank geometry และ IPW 
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สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Prerequisite 

mill_contour operations Zlevel and Fixed Axis that contain a tool 
path. Operation tool with a holder and or a shank, with Check Tool 

and Holder turned off. 

Zig and Zigzag cut patterns. 

Command Finder Divide by Holder  

Operation Navigator — 
Program Order View Right click the cutting operation→Tool Path→Divide by Holder 

 
 
Cut area selection by edge-bounded region 

คณุสามารถลดความซบัซ้อนของการเลอืก cut area ส าหรับ contouring operations โดยระบุ 
face และ ก าหนดขอบเขต closed boundary of edges ซึง่ NX จะท าการเลอืกผิวที่เลอืกไปจนถึงขอบเขต
ท่ีก าหนดไว้ การเลอืกผิวสามารถเลอืกอยูร่ะหวา่งการเลอืกสองขอบเขตได้ 

ตามตวัอยา่งแสดงการเลอืกของ edge-bounded face region.  

 

เลอืกผิวหนึง่ผิว บริเวณท่ีต้องการ 
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ก าหนด closed boundary of edges เพื่อ
บอกขอบเขต ซึง่ในขณะเดียวกันผิวที่เลอืกไว้
จะเปลีย่นเป็นสอ่ืีนแทน  

 

NX จะท าการขยายการเลอืกผิวไปยงัขอบเขต
ท่ีต้องการ  

  แสดงผิวที่อยูร่ะหวา่งสอง closed edge boundaries 

 

สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Prerequisite A fixed-axis contour operation 

Location in dialog box Cut Area dialog box→Edge Bounded Face Region group 

 
 
Safer engage and retract moves for Zlevel operations 

ออปชัน่ควบคมุการเคลือ่นท่ีของ tool ใน Zlevel Profile และ Zlevel Corner operations เม่ือ tool 
engages เข้างาน และ retracts ออกจากชิน้งานในลกัษณะ open area arc และ ramping moves 
ในขณะนีมี้สามออปชัน่ช่วย เช่นเดียวกบัใน fixed contour ในเวอร์ชัน่ก่อนหน้านี ้
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ใช้ออปชัน่ Arc – Parallel to Tool Axis เม่ือ XY-
plane arc ไม่ practical. 

 

ใช้ออปชัน่ Arc – Normal to Tool Axis ซึง่ภายในจะ
มีออปชัน่ Ramp Angle เพื่อให้มัน่ใจวา่ Z-level cut 
engages และ retracts ปลอดภยัจากการกดัเนือ้
งานท่ียงัเหลอือยูท่ี่พืน้  

 

ใช้ออปชัน่ Arc – Normal to Part เพื่อลด cutter 
load ระหวา่ง engages ในบริเวณมมุท่ีเหลอือยู ่

สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Prerequisite A Zlevel operation 

Location in dialog 
box 

Path Settings group→Non Cutting Moves dialog box→Engage 
tab→Open Area group→Engage Type 

 
Smooth noncutting motions in contouring and flowcut operations 

ส าหรับ contouring, flowcut และ turbo operations คณุสามารถใสค่า่ engage, retract, และ
การเคลือ่นท่ีของ stepover ภายใน region โดยใช้ออปชัน่ใหม่คือ Override with Smooth Connection ซึง่ 
NX จะปลอ่ยคา่การเคลือ่นท่ี smooth continuous ตามแนวเส้น tool path ระหวา่ง cutting motions ให้ 

คณุสามารถที่จะก าหนด  
 ระบุคา่ length ส าหรับยืด cutting motion 
 ระบุคา่เพื่อยืดการเคลือ่นท่ีการยกออกจากชิน้งาน  
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 ระยะหา่งมากสดุของ stepover ท่ีจะสามารถ connect ของการเคลือ่นท่ี retract, traversal และ 
reengage  

 Tolerance ส าหรับ drive point distribution ตามแนวการเคลือ่นท่ี connecting  
 ระยะหา่งระหวา่ง region ท่ี connect ด้วย lowest safe Z หรือ clearance plane 
 Part safe clearance จะช่วยในการ approach, departure และ traversal ซึง่เป็นระยะหา่งที่
ปลอดภยัจากชิน้งาน คณุสามารถที่จะให้ clearance เพื่อเลีย่ง IPW 

เม่ีอระยะหา่งของ stepover มากกวา่ที่ก าหนด การเคลือ่นท่ีจะเป็นลกัษณะ rapid โดยยกขึน้ด้านบนใน
ระหวา่งแตล่ะ regions ซึง่คณุสามารถก าหนดเปลีย่การเคลือ่นท่ีในลกัษณะ corner เป็น smoothing ได้ใน 
rapid motion 

 

(1) Smooth stepover motions — length and height are applied in proportion 
(2) Smooth traversal motion — length and height are fully applied 

ท ำไมถึงควรใช้? 

ออปชัน่ใหม่นีช้่วยให้ปลอดภยั ได้ประสทิธิภาพท่ีดี การเดินงานท่ี smooth และภายในค าสัง่มี
ตวัเลอืกให้ตัง้คา่ไม่มาก แตไ่ด้ปรสทิธิภาพท่ีรองรับการใช้งานได้อยา่งสมบูรณ์  

สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Prerequisite 

Open the Non Cutting Moves dialog box from a contouring or flow cut 
operation dialog box.  

Location in dialog 
box Non Cutting Moves dialog box→Smoothing tab 
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Improving 3D IPW efficiency in Cavity Milling 
เม่ือคณุสร้าง Cavity Mill operation และใช้ 3D IPW คณุสามารถตดับางสว่นออกจากการกดั 

ด้วยการใช้ออปชัน่ Minimum Material Removed  

คณุสามารถที่จะควบคมุการกดัตอ่ลงไปด้านลา่ง ด้วยการใช้ออปชัน่ Cut Below Overhanging Blank  

 ถ้าคณุไม่ได้เลอืก Cut Below Overhanging Blank check box  การกดังานกดัเฉพาะตามท่ี
เห็นใน IPW เหมือนกบัก่อนหน้านี ้การเคลือ่นท่ีในลกัษณะนีจ้ะช่วยป้องกนั tool path ท่ีไม่จ าเป็น และ
ลดการสญูเสยีเวลา-ของเคร่ืองจกัร 

 ถ้าคณุเลอืก Cut Below Overhanging Blank check box การกดังานจะเดินลงไปถึงด้านลา่ง
ของ IPW ซงึการกดังานในรูปแบบนีจ้ะเป็นการไปเพิ่มเวลาบนเคร่ืองจกัร  

  

Cut Below Overhanging Blank  Cut Below Overhanging Blank  

ท ำไมถึงควรใช้? 

 ช่วยลดเวลาในการกดั เม่ือมีเนือ้งานอยูด้่านลา่ง  

 เพิ่มประสทิธิภาพของ tool path ท่ีคณุไม่สามารถใช้ได้ในออปชัน่ Level Based IPW  

สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Prerequisite A Cavity Mill operation 

Location in 
dialog box 

Cavity Milling dialog box→Path Settings group→Cutting Parameters 

→Cutting Parameters dialog box→Strategy tab→Extend Path group 
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Turning enhancements 
Centerline Drilling depth enhancement 

ออปชัน่ใหม่ Depth Reference มีการเพิ่มเข้าไปในออปชัน่ drilling depth ซึง่ออปชัน่นีจ้ะช่วยให้
การควบคมุความลกึงา่ยขึน้  

คณุสามารถอ้างอิงความลกึได้จาก tool tip หรือ shoulder  

Tool tip  

 

Shoulder depth  

 

การใสค่า่ offset 20 จากคา่ความลกึไปถึง tool shoulder 

 

สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Prerequisite A centerline drilling operation 

Operation Navigator 
Double-click a drilling operation→Start Point and Depth group→Depth 
Reference 

Location in dialog 
box Drilling operation→Start Point and Depth group→Depth Reference 
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Turning non cutting moves enhancements 
Non-cutting moves ของงาน roughing, finish turning และ threading ในตอนนีส้ามารถก าหนด 

Local Return Move ได้ตามออปชัน่ท่ีเพิ่มขึน้ตอ่ไปนี ้

 Clear Radial->Clear Axial->Direct 

 Clear Radial->Axial->Radial 

 Clear Radial->Clear Axial 

จะสงัเกตเห็นการชนของ tool กบัชิน้งาน 

 

Radial->Axial->Radial option 

จะสงัเกตเห็นวา่ไม่เกิดการชนของ tool กบัชิน้งาน 

 

Clear Radial->Axial->Radial option 

 1: Local return point 
 1: Local return point 

 2: Radial clearance plane 

ท ำไมถึงควรใช้? 

คณุสามารถก าหนดการเคลือ่นท่ีออกจากชิน้งานในลกัษณะการกลงึ inside diameter หรือ threading ได้
ดีขึน้ 

สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Prerequisite A turning operation 

Location in 
dialog box 

[Turning operation] dialog box→Path Settings group→Non Cutting Moves 

→Non Cutting Moves dialog box→[appropriate tab] 

 



91 
 

www.facebook.com/dtmthailand  www.dtm-thailand.com 

Parting off operation 
ใช้ Part Off operation เพื่อ 

 แยกชิน้งานเป็นสองชิน้ 

 ตดัร่อง groove ใน IPW ซึง่จะสามารถตดัหรือแยกชิน้งานได้งา่ยขึน้ 

 

Note Part Off Position และ Depth จะไม่แสดงใน Path Settings group ตามคา่ default ถ้าต้องการให้
แสดงออปชัน่ จะต้องท าการ customize dialog box เพิ่มขึน้มา 

ใช้ออปชัน่ตอ่ไปนีเ้พื่อก าหนดคา่การกดัลกึลงไป 

 Divide: tool จะลงมาถึง centerline หรือผนงัด้านในของ IPW และสามารถยืดความลกึลงไปได้ ซึง่
การใช้งานในลกัษณะนี ้เม่ือจ าลองการท างานจะเห็นเนือ้เหลอืทัง้สองด้านในบริเวณมมุของ insert 
หากไม่ได้ยืดความลกึลงไป 

 Clean First Wall:  tool จะหยดุหลงัจากท่ีปลาย tool ด้านแรกผา่น centerline หรือผา่นผนงัด้าน
ในของ IPW และสามารถยืดความลกึลงไปได้ ซึง่การใช้งานในลกัษณะนี ้เม่ือจ าลองการท างานจะเห็น
เนือ้เหลอืด้านหนึง่หากใช้ tool ท่ีมีหน้าเอียง และไม่ได้ยืดความลกึลงไป  

 Clean Both Walls: tool จะหยดุหลงัจากท่ีปลาย tool ทัง้สองด้านผา่น centerline หรือผา่นผนงั
ด้านในของ IPW และสามารถยืดความลกึลงไปได้ ซึง่การใช้งานในลกัษณะนี ้เม่ือจ าลองการท างานจะ
เห็นวา่ไม่เหลอืเนือ้ทัง้สองด้าน 
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 Stock: tool จะเข้ามาถึงระยะความหนาน้อยสดุของระยะหา่งระหวา่ง centerline หรือผา่นผนงั
ด้านในของ IPW  

 Distance: เป็นการควบคมุระยะหา่งของ tool เข้ามาถึง centerline 

สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Prerequisite A groove operation 

Location in dialog box Rough Turn OD operation→Cut Strategy group→Part Off 

 
Threading non cutting moves enhancements 
ใช้ infeed engage motions เพื่อหลกีเลีย่งการเข้าเนือ้ชิน้งาน ซึง่ Infeed motions ช่วยให้การเข้างานใน
ลกัษณะ multiple starts ส าหรับ threading operation ได้ 

 

Threading without infeed motions 
 

Threading with infeed motions added 

 1. Engage motion 

 2. Engage angle 

 3. Root line 

 4. Retract motion 

 5. Crest line 

 1. Infeed motion 

 2. Infeed length 

 3. Infeed angle 

 4. Start line 

 5. Start line angle 

คณุสามารถก าหนดได้ตามนี ้ส าหรับงาน rough และ finish passes ใน threading operations 

 ก าหนดคา่ local return 

 ก าหนดตาม user-defined machine ควบคมุลกัษณะของ local returns 

 ก าหนด local returns โดยใช้ number of starts หรือ number of passes 
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ท ำไมถึงควรใช้? 

ใช้การเลือ่นท่ี infeed engage ในพืน้ท่ี ท่ีชิน้งานไม่มีพืน้ท่ีในการยืดการเข้างานออกมา 

สำมำรถเรียกค ำส่ังได้ที่ 

Application Manufacturing 

Prerequisite A threading operation 

Location in dialog 
box 

[Turning threading operation] dialog box→Path Settings group→Non 

Cutting Moves  

Non Cutting Moves dialog box→Engage tab or Local Return tab 

 

 

 

 

 

 


